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1 A2 1.1 RGi5EH)

j -

1.1 RGN

Gowin_EMPU_M3, GFE =245, Wi 1-1 s

5 2]
1-1 RG 54
MCU Core System AHE Bus System APB Bus System
IRC[15:0]
St
_ * NI Frocessar M GHO AR
ars Macrocel
UART1
Ethernet
Debug Serial Timerd
Arcess Wire
Fort Viewer DOR3
Flash Data AHB { WatchDog
Pstch | |Watchpoints Bridge [AHB 2APE
AHBZ Bridge
Ererin
Bus Martixc
Code SRAM and Peripheral
Interface Interface F
Edension
Instruction Dats
Memary Memary

%—%, MCU Core System, fu#i ARM Cortex-M3 Processor Core.
Instruction Memory A1 Data Memory, UL Peripheral Interface.

% 2, AHB Bus System, f#5i GPIO. Ethernet. DDR3 Memory.
SPI-Flash #1 AHB2 Extension.

% =%, APB Bus System, fiff UARTO. UART1. TimerO. Timer1.
WatchDog. RTC. 12C Master. SPI Master 1 APB2 Extension.
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1 fEIF2EH

1.2 RGHHIE

1.2 RGHFHE

Gowin_EMPU_M3, A= T ARG 4HM:
MCU Core System 1 R4t

AHB Bus System - &%t

APB Bus System T #4;

1.2.1 MCU Core System F %%t
SRR

IPUG923-1.2

ARM architecture v7-M Thumb2 154 822¥8), HF 16-bit 1 32-bit 54
3

¥ H MPU (Memory Protection Unit)

S FF WIC (Wakeup interrupt Controller)
> Bit-banding

¥ sleep mode HUFE B, [FIKRGZIhFE
Hh Ty S A RN I 2R FE AR
SCREEHRE AR 2 K /A% 2
RGP @ 40MHZ DA

NVIC (Nested Vector Interrupt Controller)

Bk 16 AN P e AL 5, FIT P B A R P AT L)
K 256 ZEh IR 56 51 2
HEN T AE RIS 4 S (A7 LT B RAS o AT R 1 3 ST AR A

SRR R AT

No debug

Minimum debug

Full debug minus DWT (Data Watchpoint and Trace)

Full debug plus DWT

XFFRIAE O A

Serial Wire

JTAG and Serial Wire

HF Trace F9 L& :

No trace

Standard trace. ITM (Instrumentation Trace Macrocell and DWT (Data
Watchpoint Trace) , No ETM (Embedded Trace Macrocell)
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1 fEIF2EH

1.3 &G M

® Full trace. ITM, DWT and ETM

® High trace. ITM, DWT, ETM and HTM (AHB Trace Macrocell)

Memory

Instruction Memory: 1547t %%, Size 7] Aic & A 16KB. 32KB. 64KB
5%, 128KB, S HF bootload HIUH{E SNk

Data Memory: s f7-fit#%, Size Al ALE v 16KB. 32KB. 64KB X

128KB.

1.2.2 AHB Bus System FH %t

AHB S &% A e
GPIO

Ethernet

DDR3 Memory
SPI-Flash

AHB2 Extension

1.2.3 APB Bus System F& %t

APB 28422 /#1545 -

® UARTO/1
® Timer0/1
® \WatchDog
® RTC
® |2C Master
® SPI| Master
® APB2 Extension

1.3 RGtis 0

Gowin_EMPU_M3 &%t € X, 5 1-1 Frs.

*® 1-1 RGisOEX
AR /o | f%E | fEk R RN
HCLK in 1 RGP -
hwRstn in 1 KRG EN -
LOCKUP out |1 W lockuptk 25 -
HALTED out |1 M #halt debugih 7 -
JTAG 3 inout | 1 WiRE I TRSTN
JTAG_ 4 inout | 1 W CINC DAP
JTAG 5 inout | 1 Wik TDI

IPUG923-1.2 3(30)
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R /o | fi%E | fik Bk
JTAG 6 inout | 1 Wi INC
JTAG_7 inout | 1 Wik O TMS/SWDIO
JTAG_8 inout | 1 ik THOLDN
JTAG_9 inout | 1 Wik O TCK/ISWCLK
JTAG_10 inout | 1 Wik S0
JTAG_11 inout | 1 WA INC
JTAG 12 inout | 1 iR O SCLK
JTAG_13 inout | 1 Wik O TDO/SWO
JTAG 14 inout | 1 WA SI00
JTAG_15 inout | 1 Wik O SRSTN
JTAG_16 inout | 1 Wik OCs
JTAG_17 inout | 1 W OINC
JTAG_18 inout | 1 iR TWPN
IRQ in [15:0] | H P hiWr b BEAE 5 NVIC
GPIO inout | [15:0] | i %A % H g 1 GPIO
UARTORXD in 1 UARTOFZ St [
UARTOTXD out |1 UARTO & % i 1 UARTO
UART1RXD int 1 UART 128 [

UART1
UART1TXD out |1 UART LA i % [
TIMEROEXTIN in 1 Timer04h34s o 7 Timer0
TIMER1EXTIN in 1 Timer14hs H Timerl
RTCSRCCLK in 1 RTCH£0J532.768KHz RTC
SCL inout | 1 H AT I Aol 12C
SDA inout | 1 AT A Master
MOSI out |1 F 1 % i BN
MISO in 1 B SN N & sp|
SCLK out |1 RS Master
NSS out |1 ML IEFRAF T
RGMII_TXC out |1 RGMIIR IR B
RGMIl_TX_CTL out |1 RGMII A 1%l
RGMIl_TXD out |[3:0] RGMIUKE IE 0 HE Ethernet
RGMIl_RXC in 1 RGMIHZ S RGMII
RGMII_RX_CTL in |10 RGMIE s Interface
RGMII_RXD in [3:0] RGMIHZ A
GTX_CLK in 1 RGMII 125MHzH 4 A
GMII_RX_CLK in 1 GMIHZ S i Ethernet
GMII_RX_DV in 1 GMIlZE Yl B GMIl
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B S 110 DA 5% Bk
GMII_RXD in [7:0] | GMIHE IS Interface
GMII_RX_ER in GMIZ S 7
GTX_CLK in 1 GMII 125MHzH &8 A\
GMII_GTX_CLK out |1 GMIIK L]
GMIl_TXD out | [7:0] GMIK % £
GMII_TX_EN out |1 GMIIKIEAf fE
GMII_TX_ER out |1 GMIIR &, %
MIl_RX_CLK in 1 MIHZSC I
MIl_RXD in [3:0] MR
MII_RX_DV in 1 MUY fd e
MIl_RX_ER in 1 MU ISR 1%
MII_TX_CLK in |1 MR R ,'\Eﬂtnemet
MII_TXD out | [3:0] M1 % £ Interface
MII_TX_EN out |1 MIIA & fd e
MIL_TX_ER out |1 MILR %45 1%
MII_COL in 1 M RAE =
MIl_CRS in 1 MIERAE 5
MDC out |1 B THL 3 3 I e
Ethernet
MDIO inout | 1 BB TE B
DDR_CLK_| in 1 S50MHzI g A\
ere o O Tout |1 TR ILSE S
DDR_ADDR_O out | [15:0] | Rowittitik. Columnifiit
DDR_BA O out | [2:0] Bankiitik
DDR_CS N O out |1 FrikfES
DDR_RAS N_O out |1 RowHh ik 168 15 =
DDR_CAS _N_O out |1 Columniti il 138 (= 5
DDR_WE_N_O out |1 Row 5 i fi&
DDR_CLK_O out |1 ii%’%ﬁ%é%DDRs SDRAM[MI 415 | DDR3
DDR_CLK_N_O out |1 5DDR_CLK_ O EMES
DDR_CKE_O out |1 DDR3 SDRAMIt i {5 5
DDR_ODT_O out |1 WAFAE = o 22 FL P 2 1
DDR_RESET_N O |out |1 DDR3 SDRAME {15 5
DDR_DQM_O out | [1:0] DDR3 SDRAMA i B k(5 5
DDR_DQ IO inout | [15:0] | DDR3 SDRAM%#f
DDR_DQS_IO inout | [1:0] | DDR3 SDRAM¥ ¥k iE(5 5
DDR_DQS_N_IO inout | [1:0] 5 DDR_DQS_IO4 W E 055
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R /o | fi%E | fik Bk
ELASH_SPI_HOLD inout | 1 NG
FLASH_SPI_CSN inout | 1 MRS IEBEE S
FLASH_SPI_MISO |inout |1 F N SPI-Flash
FLASH_SPI_MOSI |inout |1 FF A RSN
FLASH_SPI_WPN | inout |1 NC
FLASH_SPI_CLK inout | 1 85 5
APB2PSTRB out |[[3:0] |APB2PSTRB
APB2PPROT out |[[2:0] | APB2PPROT
APB2PSEL out |1 APB2 PSEL
APB2PENABLE out |1 APB2 PENABLE
APB2PADDR out |[31:0] | APB2 PADDR
APB2PWRITE out |1 APB2 PWRITE APB2
APB2PWDATA out |[31:0] | APB2 PWDATA Extension
APB2PRDATA in [31:0] | APB2 PRDATA
APB2PREADY in 1 APB2 PREADY
APB2PSLVERR in 1 APB2 PSLVERR
APB2PCLK out |1 APB2 PCLK
APB2PRESET out |1 APB2 RESET
AHB2HSEL out |1 AHB2 HSEL
AHB2HADDR out |[31:0] | AHB2 HADDR
AHB2HTRANS out |[1:0] | AHB2 HTRANS
AHB2HWRITE out |1 AHB2 HWRITE
AHB2HSIZE out |[2:0] | AHB2HSIZE
AHB2HBURST out |[2:0] | AHB2 HBURST
AHB2HPROT out |[3:0] | AHB2 HPROT
AHB2HWDATA out |[[31:0] | AHB2 HWDATA AHB2
AHB2HMASTLOCK |out |1 AHB2 HMASTLOCK Extension
AHB2HREADYMUX |out |1 AHB2 HREADYMUX
AHB2HRDATA in [31:0] | AHB2 HRDATA
AHB2HREADYOUT | in 1 AHB2 HREDAYOUT
AHB2HRESP in [1:0] | AHB2 HRESP
AHB2HMASTER out |[[3:0] | AHB2 MASTER
AHB2HCLK out |1 AHB2 HCLK
AHB2HRESET out |1 AHB2 RESET
6(30)




1 fEIF2EH

1.4 KRG RFE S

14 REHFEST

Gowin_EMPU_M3 R4 %7 S, 3k 1-2 Fios.

* 12 ARG HFgt
- Resources || y1s | Registers | BSRAMs |\D/|25ros
MCU Core System Minimum and No Peripherals 17138 | 2245 16 2
MCU Core System Default and No Peripherals 22732 | 4634 64 2
MCU Core System Maximum and No Peripherals 25290 | 5571 128 2
MCU Core System and All Peripherals Maximum 37345 12981 111 2
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2 W Bt iAE 2.1 TEfFIR I

2 BfitRi=

2.1 FEHIFR

DK-START-GW2A55 V1.3: GW2A-LV55PG484C8/I7

2.2 B IrGE
Gowin_V1.9.8Beta & L FhR 4.
2.3 IP Core Generator

52 SR = JEOH AR IP Core Generator, fHT-FC & flp= 4
Gowin_EMPU_M3 fifif:-% 1t

2.4 Programmer
Gowin F##4 Programmer, B T8 44 i SCAFE AR AE w30 BIN

AR
Programmer B AE{EH 777k, 2% SUG502, Gowin Programmer /#
S5
25 Wi R

Gowin_EMPU_M3 & A

1. IP Core Generator H it & MCU Core System.AHB Bus System #1 APB
Bus System, 7#fE Gowin EMPU_M3 %11, SN 2407 TiE;

2. 2%k Gowin_ EMPU_M3 Top Module, S A/ N AT, M-
N 35 Gowin. EMPU_M3 Top Module;

VIER LA 7 29 3 5

GowinSynthesis 56, AR S

Place & Route i Jaiffik, A= Bihd i A

Programmer #5314 %) GW2A-55/GW2A-55C/GW2AN-55C.

o g kA w
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3 TREREAR

3.1 Bl TRE

3.1 BT
3.1.1 81T

MAHAT I = IR EAT, EFESE A~ “File > New..

)& FPGA Design Project, & 3-1 fizs.
3-1 813 FPGA Design T2

w

‘
T g o

= j
b e S

TIERW

. > FPGA Design Project”,

Recent Projects:

G New ? X

¥ Projects a

E FPGA Design Project

~ Files
_Q Verilog File
| & VHDL File L
| & Physical Constraints File

¢ Timing Constraints File v

Create a FPGA design project.
You will be able to add or create RTL sources, run synthesis,
place & route, and program your device.

Manual for LitileBee Manual for Arora

Start Page [x ]

3.1.2 EILIERMMEBEE

BN TREAPR, WP LREHAE, Wk 3-2 s,

IPUG923-1.2
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3 LREMEIR 3.1 Bl TRE

B 3-2 BTG HMEEE

W Project Wizard x

Project Name
E> Project Name
Select Device Enter a name for your project, and specify a directory where the project will be stored. The directory will be

created if it doesn't exist.
Summary

Name: ‘gowiniempuima ‘

Create in: ‘F:\ |

[ Use as default project location

ext = Cancel

3.1.3 iEFFERE

1%#¢ “Series”. “Device”. “Package”. “Speed” #l “Part Number”,
ﬁu@ 3'3 Fﬁﬂ—_‘—\‘o

LU R T RAZ it N, ks ps:
Series: GW2A

Device: GW2A-55C

Package: PBGA484

Speed: C8/I7

® Part Number: GW2A-LV55PG484C8/17

[ 3-3 ik

W Project Wizard *

Select Device
Project Name

E» Select Device Specify a target device for your project
Summary Filter
Series: | GW2A | Device: GW2A-55C -
Package: PBGA484 -
Speed: Cai7 -

Part Number Device Package Speed  Voltage 10 LuUT Fi
GW2A-LVS5PGABACB/I7 GW2A-55C PBGAdB4 | CB/IT 54720

= Back Cancel

g
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3 TREMAR 3.2 Wit

3.14 Se T ERIE
P 3-4 iR, SERk T RLAIE.
E 34 =R TigaE

W Project Wizard X
Summary
Project Name
Select Device Project
IE:‘) Sromeny Name: gowin_empu_m3

Directory: F:\
Source Directory: F:\gowin_empu_m3\src
Implementation Directory: F:\gowin_empu_m3\impl

Device
Part Number: GW2A-LV55PG484C38/I7
Series: GW2A
Device: GW2A-55C
Package: PBGA434
Speed: C8/I7

= Back Cancel

3.2 Bt

i F IP Core Generator /%4 Gowin_ EMPU_M3 fifi %11

HFEEHAEL “Tools > IP Core Generator” 5 T. &A% IP Core Generator
“&% 7, 4TIF IP Core Generator.
1% “Soft IP Core > Microprocessor System > Soft-Core-MCU >
Gowin_EMPU_M31.0”7, tn&l 3-5 fi7s.
& 3-5 #&#¥ Gowin_ EMPU M3

& GOWIN FPGA Designer ore Ganerator] -

)

8x Target Device:  GW2A-LV55PG484C8NT7
em.
Name Version " i
Gowin_EMPU_M3
BandGap

Information
Type: Goi
Vendor: GOWIN S
Summary

16

10

12

i

Design | Process  Hierarchy Start Page Design Summary
Console #x

I Gowin_EMPU_M3, R&i4itytn& 3-6 fis.
f1F5“MCU Core System”. “AHB Bus System” i1 “APB Bus System”

IPUG923-1.2 11(30)




3 TREMAR 3.2 Wit

ZRTRGME .
3-6 RGtHRaE

W Gowin EMPU M3 ? X
File
Device:  |GW2A-55C Part Number: |GW2A-LV55UG324C8/17 |

Create In: |C:\Users\liukai\Documents\gowin_empu_m3 |

Language: |Verilog ¥ | Synthesis Tool: | GowinSynthesis -
MCU Core System AHE Bus System APB Bus System
IRO[15:0]
5 Embedded GRIO UARTO
N i e R
Core
Macrocel
UARTT
Debug Serial Timerd
Accesz Wire —=
Port Viewer
Flash Dats AHE * VistchDog
Bstch | |Watthpoints Bridge AHE 278
AHEZ Eridge
Bus Martic
Code SRAM and Peripheral
Interface Interface F
Exctenzion

Instruction Data
Memary Memary

Cancel

3.2.1 MCU Core System ECE

MCU Core System ¥ 24 E LT, Wk 3-1 fros.
%z 3-1 MCU Core System Bt B %1

Hic B i 15 Eitipa

TFA64 7 WAL B S, T e R T AR B T RE s
ERIA KA o

Enable User Interrupts

{#iEMemory Protection Unit;

Enable MPU A
BRINERE
fiEWakeup Interrupt Controller;
Enable WIC o P P

FRINAERE -

{# §EBit-banding;

Enable Bit-banding e A
EIN7 Heo

IRQ Priority Level Pic B HR TR e g v, A YE I 3~8;
Width ERNHUE 3.

fic. & Wakeup Interrupt Controller Lines, HU{E{uH3~243;

WIC Lines BRI A3

IPUG923-1.2 12(30)




3 TREMAR 3.2 Wit

Pic 3% T Eiiipay

Pie B RS

No debug

Minimum debug

Full debug minus DWT
Full debug plus DWT
RIAFull debug plus DWT

Debug Level

Hic B RS RGHF N

No trace

Standard trace. ITM and DWT, No ETM

Full trace. ITM, DWT and ETM

High trace. ITM, DWT, ETM and HTM
#Ri\Standard trace. ITM and DWT, No ETM

Trace Level

Fic B e O

Serial wire

JTAG and serial wire
ZRINITAG and serial wire

Debug Interface

Instruction Memory IU{E16KB. 32KB. 64KB1}128KB;
Size ZRIN64KB.

Initialization File Path bootload ¥ 4G 1E /4442, FT A #hSPI-Flash F #J5 3) .

U 16KB. 32KB. 64KBE{128KB;

Data Memory Size
Y Ri\64KB.

X MCU Core Systm, FTJF MCU Core System Bt &£, fLFE
Configuration. Debug- Instruction Memory 1 Data Memory Bt & %I .

Configuration

% £ Configuration Bt & %10, 4P 3-7 i, 7] LKL & User Interrupts.
MPU. WIC. Bit-banding. IRQ Priority Level Width 1 WIC Lines.

IPUG923-1.2 13(30)




3 TREREAR

3.2 Bt

IPUG923-1.2

[#] 3-7 Configuratio

5 MCU Core System ? X

MCU Core System o

Gowin_EMPU_M3 is built on 2 high performance processor core Cortex-M3, with a 3-stage pipeline
Harvard architecture, making it ideal for demanding embedded applications, and is integrated inte
Gowin FPGA.

MCU Core System includes MCU Core, Instruction Memery and Data Memary.

In MCU Core, user can cenfigure external user interrupts, MPU, WIC, IRQ priority level width, WIC lines,

bit-banding, debug level, trace level and debug interface.
In Instruction Memory and Data Memary, user can configure instruction memory size, initialization file
path and data memory size.

Options
Configuration ~ Debug  Instruction Memory — Data Memory
[ Enable User Interrupts
Enable MPU
Enable WIC
Enable Bit-banding

6 14
e 1s IRQ Priority Level Width: [3 [2]3 ~ )
AG 16 WIC Lines: [3 ~ 243)

N R R I

Gowin EMPU M3

Cancel

User Interrupts fit &

- Gowin_EMPU_MS3 #&fit 16 NH P Rl kb35S, HTHP®&Y
JE T AL EE T BE

- W%k #$E Enable User Interrupts, M) Gowin_ EMPU_M3 75 H /'
WrsbsE, AR

. N/ CNP
MPU Ac &

- W% Enable MPU, Il Gowin EMPU_M3 3 #F MPU, %A
o

- BOAEFE
WIC B &

- W% Enable WIC, ] Gowin_ EMPU_M3 37 WIC, HIA
o

- Bk
Bit-banding fic &

- % $¢ Enable Bit-banding, I Gowin_ EMPU_M3 7 #F
Bit-banding, 7 NIANSZ#E.

- Bk
IRQ Priority Level Width fit &
- BCE LA, BUETEH 3~8, W LASCRF 8~256 4¢ Lot
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e
- BN 3.
® WIC Lines L&
- [CE WIC Lines, HUEJuH 3~243.
- BN S,
Debug

i1%63% Debug I B i 11, 41 & 3-8 Fro, A LARC & Debug Level. TraceLevel
#1 Debug Interface.

[¥] 3-8 Debug

5 MCU Core System ? X

MCU Core System o

Gowin_EMPU_M3 is built on a high performance processor core Cortex-M3, with a 3-stage pipeline
Harvard architecture, making it ideal for demanding embedded applications, and is integrated into
Gowin FPGA.

MCU Core System includes MCU Core, Instruction Memory and Data Memory.

In MCU Core, user can configure external user interrupts, MPU, WIC, IRQ priority level width, WIC lines,
bit-banding, debug level, trace level and debug interface.

In Instruction Memory and Data Memory, user can configure instruction memory size, initialization file

path and data memory size.

@ Standard trace. ITM and DWT, No ETM (O High trace. ITM, DWT, ETM and HTM

—
-
76 3
ING 4 [
IG5 [
ITNG 6 (-
e Options
ITNG T [
TG o [ Configuration ~ Debug Instruction Memory ~ Data Memory
ITG 9 (-
Debug Level
ITAG 10 jg s
TAG 11 e O No debug O Full debug minus DWT
TG 12 [ © Minimum debug @ Full debug plus DWT
| e TG 13
. Trace Level
4G 15 [ O No trace O Full trace. ITM, DWT and ETM
>
[
-

Debug Interface

Serial wire
Gowin EMPU M3 o

® JTAG and serial wire

=

® Debug Level fic &
MEE HIX ARG REEL, -
- No debug
- Minumum debug
- Full debug minus DWT
- Full debug plus DWT
3!
BRIl Full debug plus DWT,
® Trace Level it &
Ne & PRI R AT RESE, BLA:

-  No trace

IPUG923-1.2 15(30)
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- Standard trace. ITM and DWT, No ETM
- Full trace. ITM, DWT and ETM
- High trace. ITM, DWT ETM and HTM
7!
RN Standard trace. ITM and DWT, No ETM.
® Debug Interface it &
Bo B R 2R A, FE.
- Serial wire
- JTAG and serial wire
!
RN JTAG and serial wire .

Instruction Memory

¢ Instruction Memory it Bk, @il 3-9 Frw, Al UL E Instruction
Memory Size # Initialization File Path.

3-9 Instruction Memory

MCU Core System ? X

MCU Core System &

Gowin_EMPU_M3 is built on a high performance processor core Cortex-M3, with a 3-stage pipeline
Harvard architecture, making it ideal for demanding embedded applications, and is integrated into
Gowin FPGA,

MCU Core System includes MCU Core, Instruction Memory and Data Memory.
In MCU Core, user can configure external user interrupts, MPU, WIC, IRQ priarity level width, WIC lines,
bit-banding, debug level, trace level and debug interface.

In Instruction Memory and Data Memaory, user can configure instruction memory size, initialization file
path and data memary size.

HALTED

m6.3

TG 4

MG 5

Options
we
e Configuration ~ Debug  Instruction Memory  Data Memory
we
. Instruction Memory Size: |64KB  ~
61 Initialization File Path: F\gowin_empu_m3\bootloader
me 12

— B b

G 14

G 15

G 16

s 17

N NN NN NN NN

G 18

Gowin EMPU M3

Cancel

® |Instruction Memory Size fit &
Bi & Instruction Memory Size, 7] UL & Y 16KB.32KB.64KB Bl 128KB.
ERIA A 64KB.

® |Initialization File Path fiit &
Bic & bootload ¥IUGt 845, H T 4h SPI-Flash #5877 K. R
PEAF K Instruction Memory Size, I ANF) bootload U442, 4N
i

IPUG923-1.2 16(30)
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& Instruction Memory Size fit. & 4 16KB, Il Initialization File Path

A & T B AL INSMEM_Size_16KB bootload #14H4k 3044

1% Instruction Memory Size fic & 4 32KB, Il Initialization File Path

I AT & T BALK INSMEM_Size 32KB bootload #4444 304

1% Instruction Memory Size fic & 4 64KB, Il Initialization File Path

I AT & T BALK INSMEM_Size 64KB bootload #J#44k 304

W% Instruction Memory Size B E & 128KB, N Initialization File

Path &k 41 & T B AL INSMEM_Size_128KB bootload ¥t

e
|

Instruction Memory Initialization Path F A #645, ANREA UKL 7 i 44 1 SO R B A2

Data Memory

i%$ Data Memory fit & %351, w1/ 3-10 Fros, 7T LAAC & Data Memory

Size.

[¥] 3-10 Data Memory

MCU Core System

MCU Core System

(5 7]

wwwwww

AAAAAARARAARRRARR

Gowin EMPU M3

Gowin EMPU_MS is built on a high performance process
Harvard architecture, making it ideal for demanding embedded applicati

on Memory and Data Memory.

nterrupts, MPU, WIC, IRQ priori

erface.
In Instruction Memaory and Data Memory, user can confi
path and data memory size.

or core Cortex-M3, with a 3-stage pipeline
i and is integrated into

ity level width, WIC lines,

figure instruction memo

ry size, initialization file

Options
Configuration ~ Debug  Instruction Memery ~ Data Memory

Data Memory Size: |64KB =

Caneel

fic & Data Memory Size, FJLAECE )y 16KB. 32KB. 64KB &l 128KB.

ZRIN N 64KB.,

IPUG923-1.2
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3.2.2 AHB Bus System ECE

AHB Bus System T R4t B ik i,

mn#E 3-2 .

7% 3-2 AHB Bus System B¢ B i 15

Pic 3% 31

Eitipay

Enable GPIO

{#HEGPIO
NI %

Enable Ethernet

{fifiEEthernet
LN 3%

Interface

RN NRGMII

EthernetiZ #Interface (RGMII/GMII/MII)

RGMII Input Delay

RGMII input delay
ERUE 100

MIIM Clock Divider

MIIM clock divider
BRINE 20

Enable DDR3

{#§EDDR3 Memory
BRI\ KA

Enable SPI-Flash

ERINEfE

flifit SPI-Flash R & IhGEMMemoryit. 5. #ERRIHAE

Enable AHB2 Extension

fFEEAHB2Y e 1
LN

GPIO fit &

Wir#] I+ GPIO, W LLEFACE GPIO, Wil 3-11 fs.

5%+ Enable GPIO, ] Gowin EMPU_M3 7 GPIO, BRil kM.

3-11 GPIO it B

5% GPIO 7 X
GPIO %
[T}
The MCU core system of Gowin_EMPU_M3 interacts with GPIO black through
. AHB bus.The GPIO block interconnects with FPGA Fabric where user
ol implements general purpose I/O functions. This AHB GPIO is a general
N purpase |0 interface unit and provides a 16-bit I/O interface.
1«
ITAC 5
P
e 1757
1 b .
N g Options
- : Enable GPIO
e
.. s
e
sl
St
Tlew
pove
o
Gowin EMPU M3

IPUG923-1.2
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Ethernet B0 &
MFTH Ethernet, AT LUIAFEACE Ethernet, & 3-12 for.,

® R i%EF Enable Ethernet, Nl Gowin_ EMPU_M3 37 F Ethernet, ERiA
KMo

® N &1L+ Enable Ethernet, NIT]LIALE Interface. RGMII Input
Delay. MIIM Clock Divider,

- 1%&# Interface, TILLEFEECE RGMILL. GMII. MII B, GMII/MII, Bk
I RGMII,

- % Interface L& N RGMII, AT LLiE ARG E RGMII Input Delay,

FRMEY 100
- i%&#% MIIM Clock Divider, 7] LAECE MIIM Clock Divider, ERiAME N
20,
- R Interface i%&# RGMII 5t GMII, %55 1 GTX_CLK A4
125MHz B8 .
3-12 Ethernet Bt B
Ethernet 4 X
Ethernet %
The MCU core system of Gowin_EMPU_M3 interacts with Ethernet block through
e AHB bus.The Ethernet block is a fully verified black, which can implement
e Ethernet MAC layer function and provide RGMII/GMII/MII interface to connect to
= e PHY IC. The block implements MAC layer protocol.
T E | o
i : ‘:: Enable Ethernet
e i i Interface: RGMII  ~
4 g RGMII Input Delay:
i e MIIM Clock Divider:
Canes
DDR3 L B

X777+ DDR3, #]LLEFEACE DDR3, W& 3-13 frs.

IR %% Enable DDR3, ] Gowin_EMPU_M3 37 ¥ DDR3 Memory,
DDR3 P #4523 150MHz.
DDRS3 ¥ 1 DDR_CLK_| 4454 N\ 50MHz 3 o

IPUG923-1.2 19(30)
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[ 3-13 DDR3 it B

DDR3 ? X

DDR3 2

The MCU core system of Gowin_EMPU_M3 interacts with DDR3 block through
AHB bus.The DDR3 block provides a complete solution for customers to use
DDR3 memary. This block lacated between the DDR3 memory and the user
lagic include with Gowin Memory Controller and Physical interface, reduces
the user's effort to deal with the DDR3 memory command interface by
providing a simple generic system interface to the user

Options

Enable DDR3

(AR ERREEEREERERERRERARERE AR AR R AR ER]

SPI-Flash B0 &
SPI-Flash 32 £ N6k, A Memory . 5. EEKIRE.
X ¥T H SPI-Flash, 7] LLE#AC & SPI-Flash, 1k 3-14 Fizs.

5%+ Enable SPI-Flash, | Gowin_ EMPU_M3 3 #F SPI-Flash, &t
IMERE
3-14 SPI-Flash it &

% SPI-Flash ? X
R
SPI-Flash %1
The MCU core system of Gowin_EMPU_M3 interacts with SPI-Flash black
- through AHB bus.The SPI-Flash block is a fully verified black which can be as
i Gowin_EMPU_M3's chip-off running memory. The SPI-Flash block is SP1
™ interface.
B .
.
s
e
el s
e
o
e
iy Options
o fas
i Enable SPI-Flash
.
e
e e
.
o
s
e
es
- fow
e

AHB2 Extension B0 &

X ¥ H AHB2 Extension, 7] PLIE#AC & AHB2 Extension, 41 3-15
FrR

% Enable AHB2 Extension, ] Gowin. EMPU_M3 37 #F AHB2
Extension, H /v DATESLE: O BATEEY A AHB A6, ERIAKEH

IPUG923-1.2 20(30)
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3.2 Bt

& 3-15 AHB2 Extension &

AHB2 Extension ? X

AHB2 Extension PN

The MCU core system of Gowin_EMPLU_M3 interacts with AHB2 Extension
block through AHE bus.The AHB2 Extension block is a fully verified block
which can extend AHB bus to user to design more AHB peripherals.

Options

Enable AHB2 Extension

Cancel

3.2.3 APB Bus System ECE

APB Bus System T R4 E LI, W1k 3-3 Fios.
%% 3-3 APB Bus System Bt &%

fic & 1 10 ik
Enable UARTO gfﬁi rljﬂl 0

Enable UART1 ﬁf‘ii I‘L:ﬂl 1

Enable Timer0 ﬁfﬁi;% 0
Enable Timer gfﬁi;gﬁ 1
Enable WatchDog ;iffi;?’@

Enable RTC gf‘f;g

Enable 12C Master ﬁzﬁa‘:; Master
Enable SPI Master ﬁfﬁ;g Master
Enable APB2 Extension gfﬁ ;;;2 ¥ e

UART B¢ &

X ¥ UARTO B UART1, 7] LPLE$RACE UARTO 2 UART1, WK

IPUG923-1.2
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3'16 Fﬁ/j——;‘o

® k¥t Enable UARTO, | Gowin_ EMPU_M3 % ¥ UARTO, ERil%

N
il
\ . 4 NV
® {1+ Enable UART1, JUl Gowin_ EMPU_M3 % £ UART1, kil
N
P
[ 3-16 UART B2 &
UART ? X
UART 5=
The MCU core system of Gowin_EMPU_M3 interacts with UARTO/1 block
e through APB bus.The UARTO/1 block is a fully verified block which can
R implement UART communication. UARTO/1 block cantains two universal
. asynchronous receive/transceiver, which support maximum baud rate at
) e e 921.6Kbit/s.
— X
N
N
s 7 [
ol ey
e
R
e .
len Options
g e
e Enable UARTO
5 [ Enable UART1
<
| AT D 7l
il
o |-
2 e

Timer B¢ B

Cancel

X T Timer0 8¢ Timer1, 7] LLE SR & Timer0 &% Timer1, 4nfd 3-17

I

® 1'%+ Enable Timer0, Il Gowin_ EMPU_M3 3 #F Timer0, kA <.
® 1 ik Enable Timer1, Il Gowin_ EMPU_M3 ¥ Timer1, BRIA <.
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& 3-17 Timer Bt B

o Timer [4 X
Ti il
imer )
The MCU core system of Gowin_EMPU_M3 interacts with Timer0/1 block

o through APB bus.The Timer0/1 block is a fully verified block which can
-"_ N implement counter function. The Timer0/1 black contains two Timers, which
e support 24-bit counter.
1 1 -

— P .
g =T
0 6 -
1 1

—b i
Y =T
18 9 -
s big Options
s 1 b

=] eI
G2 e Enable Timer0
s 13
P . Enable Timerl

] TN Rl e
Epn .
s 17
S 15

Gowin EMPU M2

WatchDog B E
M idi$T H+ WatchDog, 7] LLiEF#EALE WatchDog, 41 3-18 Friws
W3Rk Enable WatchDog, il Gowin_ EMPU_M3 32 #F WatchDog,
RN o
3-18 WatchDog BL B

% WatchDog ? X

WatchDog &

The MCU core system of Gowin_EMPU_M3 interacts with WatchDog block
through APB bus.The WatchDog black is a fully verified black which can
implement system reset when system is running over.

—
e
s 3 -
S+ -
G s
— s B et
e ¢ b
5 p
i

e il Options

S T

N . G2 [ Enable WatchDog
5 -
i
s -
o -
! -
o

Gowin EMPU M3

RTC it &
WFTH RTC, wJLUEFACE RTC, & 3-19 fin.
U5 % £ Enable RTC, Il Gowin_ EMPU_M3 3 #f RTC, ZRiIASEH].
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71 RTCSRCCLK #: A\ 3.072MHz iH4t%i N, RTC A48 1HzZ.

I12C Master L &

3-19RTC L B
% RTC ? X
R,
RTC &
The MCU core system of Gowin_EMPU_M3 interacts with RTC block through

I APB bus.The RTC block is a fully verified black which can implement real time
o clock.
HALTED [
o 3 b
RN .

g hio e P
o 5 b
s s
R =T
R P

I 1 T - Options
s T
16 12 Enable RTC
s 15

. — B
1 T el
1
T8 1 -
T8 16 -

Gowin EMPU M2

M F 4TI 12C Master, wJ LLUEFACE 12C Master, 4118 3-20 s .
R %&£ Enable 12C Master, ] Gowin_ EMPU_M3 ¥ 12C Master, Zk

S SCE

& 3-20 I2C Master Bt &

' 12C Master 7 X
12C Mast 5
aster o
The MCU core system of Gowin_EMPU_M3 interacts with 12C Master block
. through APB bus.The 12C Master block is a fully verified block which can
R implement 12C communication. The 12C Master block implements 12C
T e protocol.
74
73
7 5 -
. T80T
T4 -
735
il i Options
1
Ty Enable 12C Master
I
—f gy
1B
1 -
IR
15
Py
oy
Gowin EMPU M3

SPI Master Bt &

X ¥TH SPI Master, 7] LLIEFAC & SPI Master, 1P 3-21 Fizs.
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1% $% Enable SPI Master, ] Gowin_ EMPU_M3 3 SPI Master, Zk
K
3-21 SPI Master Bt &

' SPI Master T x
SPI Master o
The MCU core system of Gowin_EMPU_M3 interacts with SPI Master block
through APB bus.The SPI Master block is a fully verified block which can
implement SPI communication. The SPI Master block implements SPI protocal.
1S
—
1 G e
10T e
e
4
4G 0 -
e s 10
a2 - Options
a3
A5 4 Enable SPI Master
4G 15 -
N
EE
e 7 e
.
e
pary =
e
Gowin EMPU M3
Cancel
APB2 Extension L&
X {T I APB2 Extension, AJ LAEFHAC & APB2 Extension, U118 3-22 it

7N o

11 5i% 4% Enable APB2 Extension, Il Gowin_EMPU_M3 37 £ APB2
Extension, H /7 rl UZEE: O HATIERED I APB AR5 %, ERIAKH

3-22 APB2 Extension B0 &

" APB2 Extension T X
APB2 Extensi o
ension %
The MCU core system of Gowin_EMPU_M3 interacts with APB2 Extension black
’ : through APBE bus.
ke The APB2 Extension block is a fully verified block which can extend APB bus to
.l o user to design more APB peripherals.
- S -
.. -
e
- N
.
(s
-
.
e Options
-
. Enable APE2 Extension
- .
-
.
— ™
-
15
N
o
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3.3 APt

® Stk Gowin_ EMPU_M3LHE )5, F=4 Gowin_EMPU_M3 R4 it
® s:fil{k, Gowin_EMPU_M3 Top Module
o S NABIT, #E#: Gowin_ EMPU_M3 Top Module 5 f v %
i, JERGEEM RTL Bt
3.4 495K

SERH T RTL it a, AR ROOT A RN /5 Z8m AN far th 19 10, 7742
YIEL AR AT

IRAEI P 2R, P 2RI i 2R S
WRRL RN =07, 2% SUG101. Gowin 1129475 -

3.5 i E

3.5.1 ZEEMECE
SEOTLE LI, & 3-23 Fios.
® RIEW IS PRTZ AR AL FREC E Top Module/Entity:;
® RE BT Y SERR ST R AR L Include Path;
® [ii& Verilog Language, 1 System Verilog 2017

3-23 TR RRALE
W Configuration X
Synthesize
G | Genera |
v Synthesize Synthesis Tool: @ GowinSynthesis
vl GE;:;:' Top Module/Entity: |GDWin7EMPU7M37temp|ate |
CGE EEEEE | " Include Path: | |
Unused Pin GowinSynthesis
Dual-Purp Pi
BitStream Verilog Language: System Verilog 2017 ~

VHDL Language: | VHDL 2008 =
Looplimit:
[] Disable Insert Pad

Ram R/W Check

[] DSP Balance

[] Show All Warnings

Cancel Apply

3.5.2 Dual-Purpose Pin EC &

Gowin_EMPU_M3 1§ ff| /i 41 SPI-Flash F#5 505 R, 54 MSPI i 1
NIEA I, i 3-24 Fis.
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36,/3‘1:1

[#] 3-24 Dual-Purpose Pin Bt &

G Configuration

Dual-Purpose Pin

General
v Synthesize
General
v Place & Route
General
Unused Pin
Dual-Purpose Pin
BitStream

A
I

BAT IR ZRE L
FRM R SCAE, e 3-25 Fﬁmo

& 3-25 &£4

5 GOWIN PG4 Designes - [
Ble Bt Bojedt Joon Windew Helb

Sy 3]

Synthesis Messages
Synthesis Details
Resource

ey Summary
Detail Timing Paths Informations

o ermpu m tmpr

b\ embecdod cartex.

[166%) Generate report
GowsnsyrEhests Finish

%

Concle | Mesnge

//TIZI

3.7 HRfhk

H 5%,

Raport T

Design Fie

(Gowinsynehesis Constraints Fie
Varsion

[] Use JTAG as regular 1O

Use S5PI as regular 10

Use MSPI as regular 10

[] Use READY as regular 10

[] Use DONE as regular 10

[[] Use RECONFIG_N as regular 10
[] Use MODE as regular 10

Use 12C as regular 10

Cancel Apply

H. GowinSynthesis, 5¢i RTL it 44, £

VEM._pubermbededcorten. Bl et 01Vipga. e desigeh DX STARY GIWZASS. W1 Sigowin smpum imelaweyrebasisigawin.swgne b syl - 8 x

Synthesis Messages

GownGTenss Repart

.88eta

Part Numbes
Oevie

Craated Time

Legat announcement

Top Lavel Moduls

GWRALVSSRGIBACHT
Gwzasac

Tue Jun 22 17:13:40 2021

CopymgHE (C12014-2021 Bowin SEMKINAIOr COmarton. ALL Nghes 1sssrysa.

Synthesis Details

me

k memory usage = 437.738HE

Paak mamary Uzage = 457.733MB
oo mory usage = 457.9 36ME
Runnng mifarance.

e, e 3 bt e yre—— b palbglaiy s 3 smopthini @4

et Ges 151\ fpga_ e dociga\DK_START GUZASS_V1. S\gerin. cmpe a3 dapi gy b g ompa A5 complated
£M0_pub\embecded\cortex_n3\ref_designil.0.1\pga_ref_design\DK_START GN2455_V1.3\jowin_empu_nd\inpligrsym

fthesis\gowin_eepu_n3_syn.rpt.hnl" completed

H5% SUG100, Gowin =R/ F 157 -

AT IR AT R An 46 1T 2 Place & Route, 5ERAT RATLE, A2 pkihg
o, ik 3-26 Froso

IPUG923-1.2
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3 TR 3.8 T#

& 3-26 Place & Route

PnR Messages

Legal Arnouncemert

. Al ights reserved.

PnR Details

MRAAEL LR, 2% SUG100, Gowin = JFH 1/ /7 151 -

3.8 T#
AT ZIRAE ) T B AE Programmer, 58 RS SCEE B R o

¥y Programmer 32 5.4%“Edit > Configure Device "8 T. E.£ Configure
Device “ 4 7, #T7F Device configuration.

® Access Mode THi%%, #£# “External Flash Mode” i£5i;

® Operation FHi41%, £ “exFlash Erase, Program thru GAO-Bridge”
o “exFlash Erase, Program, Verify thru GAO-Bridge” £ 1ii;

Programming Options > File name &1, S\ 72 TSR SO

External Flash Options > Device &£, HR#EFF &Mtk Zk Flash its 28
R oI RARAR 2, Winbond W25Q64BV);

External Flash Options > Start Address &1, FEl& A “0x000000”;
¥y “Save”, ¥l 3-27 Fis.
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& 3-27 T

Wi Device configuration ? d
Device Operation
Aooess Mode: External Flash Mode -
Operation: exFlash Erase, Program thru GAO-FBridge -

exFlash Erase, Program thru GAO-Eridge

Frogramming Options

File mame: |ART_GWZARE V1. 3/zowin_empu_m3/impl,/prr s zowin_empu_m3. f= | D

User Flazh Initialization

External Flaszh Optionz

Tlevice: Winbond WEBQG4EY -

Start Address: 0000000

Save Cancel

56 /% Device configuration J5, i Programmer T. Hf=

Program/Configure “ “0 7, 5E%A%H T %K.

N# T A Programmer {1 771%, %% SUG502, Gowin Programmer

Viilaki- AL
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4 %t

4 S5

Gowin_EMPU_M3 #2122 ¥t
Gowin_ EMPU_M3\ref _design\FPGA_RefDesign
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